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11. Simulation of dynamics of flexible bodies using UM FEM 

11.1. Basic ideas and methods 

11.1.1. Introduction 

UM FEM module  is  a  set  of  software  tools  that  are  built-in  UM Input and UM Simulation 
programs. The module gives a user a possibility to introduce flexible bodies under large displacements 
into a model of mechanical system. Flexible displacements are supposed to be small in the body-fixed 
frame of reference and could be described in terms of linear finite-element analysis (FEA). Introducing 
flexible bodies into a model of mechanical system is used for creating the more detailed models and 
obtaining more accurate results of simulation.   

In some cases modeling the system with the help of rigid bodies only is too rough approximation of a 
real system. Then some bodies of the model should be considered as flexible, for example, car body and 
chassis of transport machines. Using flexible bodies to obtain more accurate solution (coordinates, 
accelerations) and widen its spectrum that might be important in some cases, for example, for analysis of 
vibrations and durability of machines.  

UM FEM needs that UM Subsystems module is also being installed on your computer. As well as it 
is necessary that a FEA preprocessor and solver are available on your computer. The present UM FEM 
version supports import from ANSYS software version 5.5 and later. 

It supposes that you have at least basic skills in using ANSYS software and have an idea of modal 
approach. 

In this section some basic information concerning methods of simulation of flexible bodies in UM 
FEM is presented. 

Mathematical model of a flexible body is based on using the following methods: 
· subsystem technique, 
· floating frame of reference method, 
· finite-element method, 
· Craig-Bampton method. 
Every flexible body is considered as a separate subsystem that is why assembly of composite1 model 

is  similar  to  assembly  of  multibody  model.  Before  assembly  the  preliminarily  step  of  preparing  the  
necessary data of FE-model of flexible bodies should take place. Flexible bodies/subsystems can interact 
with any other rigid or flexible bodies with the help of joints and force elements. 

11.1.2. Kinematics 

Kinematics of flexible bodies is described with the help of so called floating frame of reference CS1. 
Kinematical formulas are noted in this floating frame of reference.  Position  of  certain  point  K of the 
flexible body in the global CS0 is defined as follows (Fig. 11.1): 

)( 11
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where r01 is radius vector of the origin of CS1 in CS0, A01 is transformation matrix, rk is radius vector of 
point K of undistorted flexible body in CS1, vector dk presents  elastic  displacements  of  the  point,  
superscript denotes the coordinate system in which vectors are given. 

Elastic  properties  of  the  flexible  bodies  relatively  to  the  CS1  are  described  with  the  help  of  finite-
element method. The present UM FEM version supports import of data about flexible bodies from 
ANSYS software version 5.5 and later. 
 

                                                
1 Composite or hybrid model includes both rigid and flexible bodies 
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Figure 11.1. Floating frame of reference 

 
Small elastic displacements are presented as a sum H of possible modes/shapes of flexible body: 
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where x is nodal degrees of freedom of the flexible body, jh  is the possible mode, wj is the modal 
coordinate that describes flexible displacements correspond to mode j. The matrix H is called modal 
matrix. 

According to the Craig-Bampton method the modal matrix is formed as a combination of eigenmodes 
and static modes. The method consists of four steps. 

1) Choice of interface (boundary) nodes of a finite-element scheme. 
2) Successive calculation of static modes. Static modes are static shapes obtained by given each 

boundary d.o.f. a unit displacement while holding all other boundary d.o.f. fixed. 
3) Calculation of eigenmodes while holding all interface nodes fixed; 
4) Calculation of the mass matrix and the stiffness matrix, orthonormalization of the eigenmodes and 

static modes. 
The short description of the each step is given below. 
Choice of interface nodes. Flexible body/subsystem interacts with other bodies of the model via 

joints and force elements. It is recommended that every attachment point should be situated in the node of 
finite-element mesh. Very these nodes, where joints and force elements are attached to, should be chosen 
as interface nodes. Such an approach helps to create joint constrains correctly and quite accurate describe 
flexible displacements that determine force in force element. 

It is necessary to choose interface nodes so as during calculation of each static mode the immobility 
of the subsystem was guaranteed. 

Calculation of static modes. The  number  of  static  modes  is  equal  to  number  of  d.o.f.  in  interface 
nodes. During this procedure interface nodes are held fixed and static modes are obtained by given each 
interface d.o.f. a unit displacement/rotation. 

Calculation of eigenmodes. Eigenmodes of flexible body are obtained from the solving the 
generalized eigenproblem: 

0)( =- yMС l , (11.3
) 

where С is the stiffness matrix, M is  the  mass  matrix,  λ is the eigenvalue, y is  the eigenmode. If  these 
matrices are of a full rank the equation (11.3) has N solutions, where N is the number of rows that 
correspond to nodal d.o.f. The mass matrix of the flexible subsystem may be formed based on shape 
functions of finite elements or may have a diagonal form as a result of using lumped model. A user 
determines number and shapes of used eigenmodes. As a rule a set of eigenmodes includes lower 
eigenmodes.  



Universal Mechanism 5.0                                                  Part 11. UM FEM module: flexible bodies 

 

11-4 

Calculation of generalized matrices, orthonormalization of modes. Generalized mass and stiffness 
matrices are calculated using the modal matrix H: 

MHHM T= , CHHC T=   
where M  is the generalized mass matrix, C is the generalized stiffness matrix. 

The final step of the preparing set of modes is the orthonormalization of columns of the modal matrix 
based on eigenvalue problem solution with generalized mass and stiffness matrix: 

0)( =- yMC l  (11.4) 
Transformed set of modes is formed based on the equation: 

YHH =  (11.5) 
Diagonal form of transformed generalized matrices leads to minimal CPU efforts during the 

integration of equations of motion. It is the basic advantage of such an approach. Another aim of such 
transformations is exclusion modes that correspond to movement of the flexible subsystem as a rigid 
body. It is necessary since movement the flexible subsystem as rigid one is defined by floating frame of 
reference CS1. Zero eigenvalues correspond to rigid body modes of flexible subsystem (11.4). 
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11.2. Installation, preparing data, workflow 

UM FEM installation package includes the following items: 
· macro file um.mac for ANSYS, which is written in APDL (ANSYS Parametric Design 

Language); 
· stand alone program for data transformation ansys_um.exe; 
· wizard of flexible subsystems built in uminput.exe program; 
· software procedures for handling and simulation of dynamics of flexible bodies that are built in 

uminput.exe and umsimul.exe. 
Simulation of dynamics of flexible bodies supposes the following steps to be done. 
1) Creating the FEA model of the flexible body to analyze in the external FEA software. 
2) Choosing the interface nodes, calculation of the eigenmodes and static modes according to 

Craig-Bampton method. 
3) Exporting data from external FEA software and its transformation to UM format. 
4) Including the flexible subsystem into hybrid model with the help of UM Input program. 
5) Simulation of dynamics of the hybrid model with the help of UM Simulation program. 

 
The whole workflow of the preparing input data for models that include flexible bodies is shown in 

Fig. 11.2. Let us consider basic steps of this procedure. 
The first step is executed under ANSYS environment. According to instructions to ANSYS software 

the work directory and JobName are chosen. JobName is a name of all the files for certain FEA model. 
After creating the FEA model and choosing interface nodes the macros um.mac is executed. This 

macros has commands for calculation of eigenmodes and static modes, as well as calculation and 
exporting mass and stiffness matrices. As a result of um.mac execution several files are created: standard 
ANSYS result file JobName.rst, JobName.full that contains matrices of a flexible body corresponded to 
fixed interface nodes, JobName.free that contains matrices of a free body, and JobName.mlmp with a 
diagonal mass matrix of a free body. In dependence of arguments of the um.mac the JobName.mlmp file 
may not be created. 
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   AN SYS   
·   Creating a FEA model of a flexible body   
·   Choosing interface nodes   
·   Running  um.mac  macros under ANSYS environment   

JobName.rst   
JobName.full   
JobName.free   
JobName.mlmp   

UM.MAC macros   
·   Calculating eigenmodes and static modes   
·   Calculating mass matrix of a free body   

ANSYS_UM.EXE   
·   Conver ting file formats   
·   Calculating generalized mass and stiffness matrix   
·   Orthonormalization of the modes; excluding rigid body modes   

Wizard of flexible subsystems (UMINPUT.EXE)   
·   Visual control of modes and other results 
·   Excluding shapes from the final set if necessary 
·   Orthonormalization of modes; excluding rigid body  

modes   

UMINPUT.EXE   
·   Loading input data, description of a hybrid model   
·   Generation of equations of motion   
·   Compilation of equation of motion   

UMSIMUL.EXE   
·   Simulation of dynamics and linear analysis   

input.fum   

input.fss   

input.dat   
UMTask.dll   

  

input.fss   

 
Figure 11.2. Data preparing workflow 
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After installation the um.mac file is situated in the {um_root}\bin directory. Copy the um.mac file to 
the directory that is selected as a default directory for the macro files in ANSYS. It is usually .\docu 
directory from the ANSYS root directory. Otherwise you should indicate the path to the um.mac file 
using PSEARCH command: 

/PSEARCH, path_to_um.mac. 
The second step of the data preparing is fulfilled in the ansys_um.exe program, which is situated in 

the {um_root}\bin directory. Ansys_um.exe may produce the final ready-to-use input.fss or input.fum, 
which contains intermediate data. The second way with input.fum often is more convenient for further 
analysis. 

Ansys_um.exe can be run automatically right from the um.mac or manually. To run ansys_um.exe 
automatically you should open the um.mac and edit the last line with the /sys command. The argument of 
this command should be the correct path to the ansys_um.exe program. For example, 

/sys,c:\um50\bin\ANSYS_UM.exe 
 
Note. ANSYS ignores the /sys command if it contains spaces. In order to run ansys_um.exe from 

the um.mac you should copy ansys_um.exe and um.rsc from the {um_root}\bin to the 
directory without spaces in path. 

 
The Wizard of flexible subsystems (UM Input program) gives a user additional possibilities for 

preparing data. Using the input.fum the Wizard let the user visually control the calculated modes, exclude 
some modes if necessary and fulfill all the transformations for creating the final input.fss. 

Further work flow is very similar to modeling with usual subsystems. The input.fss file is the standard 
data file for the flexible subsystem just as input.dat is a data file for the whole model. A name of directory 
that contains input.fss is considered as a name of the flexible subsystem. 

Describing a hybrid model should be done within UM Input program. This program generates a data 
file of the hybrid model input.dat, generates equations of motion and compiles them as UMTask.dll file, 
which is used in the UM Simulation program for numerical solving these equations.  
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11.3. Preparing data under ANSYS environment 

Preparing data under ANSYS environment includes three basic steps. Let us consider them more 
detailed. 

1. Describing the flexible body in terms of ANSYS according ANSYS User’s Guide. 
 
Note. It is necessary to use System International for all units. Use the command 

/UNITS,SI 
 
Note. During the preparing the data and creating a FE-mesh it is necessary to provide creating the 

nodes of FE-mesh in joint points and points of attaching force elements. To create nodes of 
FE-mesh with specified coordinates in body-fixes reference frame you can set there key 
points (K command), hardpoints (HPTCREATE command) or with the help of choosing 
appropriate parameters of automatic generation of FE-mesh. 

 
2. Selection of the interface nodes of the FE-mesh of the flexible body with the help of sequence of 

NSEL commands  or  combination  of  the  KSEL and NSLK commands. For example, you can select 
interface nodes as following: 

· NSEL,s,,,1,10,1 !selection of a new set of nodes   
             !from #1 to #10, step 1 

· NSEL,s,,,1      !selection of a new set of nodes that includes  
!one node #1 

NSEL,a,,,385    !add one more node #385 to the set of  
                !selected nodes 

· KSEL,s,,,1      !creating the a set of key points consisted of  
                !one key point #1 
KSEL,a,,,23     !add the #23 key point to the set of  
                !selected key points  
NSLK,S          !selection of a new set of nodes associated  
                !with selected key points 

 
3. Running the um.mac macro-command from the ANSYS command line: 

UM,NEForms,WayM 

NEForms - required number of eigenmodes correspond to the lowest eigenvalues of the flexible 
body; 

WayM - way of forming mass matrix: 
     0 – mass matrix, based on shape functions of finite elements; 
     1 – diagonal mass matrix. 

 
Note. If you suppose to run series of calculations with various numbers of eigenmodes it is 

recommended that you set maximal number of eigenmodes in NEForms. Once exporting 
here all the eigenmodes that could be used for all of the calculations you will be able to 
remove some of them later using the Wizard of flexible subsystems. 

 
Note. The message «6 RIGID modes defined but only 5 total modes requested. Solution not 

interesting» might appears during running UM macros. It is not a critical error and is 
connected with calculation of mass matrix of a free body. Close the error message and go on 
working. 
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11.4. ANSYS-UM data exchange 

The ANSYS_UM.EXE is considered in this section and used for importing data from ANSYS to UM. 
It converts data that made by um.mac macros and saves this data in UM format. 

Input.fss file includes set of transformed modes without rigid body modes of the flexible subsystem. 
UM Input program directly loads and supports this file for describing flexible subsystems. 

Input.fum includes intermediate data, that could be transformed with the help of Wizard of flexible 
subsystem. This file contains static modes, eigenmodes and the generalized mass matrix. 

Files *.fum and *.fss are of the same structure and contain information about modes and matrices as 
well as information andout FE-mesh, nodes and elements.  

Ansys_um includes the General and Options tabs, see Fig. 11.3. 

 
Figure 11.3.  

 
The General tab (Fig. 11.3) let the user select a*.rst file and set the target directory for saving 

input.fum / input.fss files. It is recommended to create this target directory in advance. 
 

 
Figure 11.4. 

 
The Options tab (Fig. 11.4) defines structure of output files. Following variants are possible. 
· Set of static modes and eigenmodes of the flexible subsystem, the generalized mass and the 

stiffness matrix (transformations 11.4, 11.5 are omitted). To prepare such a set of data turn off 
normalize modes flag, the rest control elements are not enabled. 

· Set of transformed modes that includes modes of motion as rigid body. To prepare such a set of 
data turn on the normalize modes flag and turn off the exclude rigid body modes flag. In this 
case to finish preparing data it is necessary to exclude rigid body modes later in Wizard of flexible 
subsystems. 

· Set of transformed modes, without rigid body modes. Turn on normalize modes and exclude rigid 
body modes flags. In this case a value in the frequency box defines maximum module of natural 
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frequency that correspond to rigid body motion. This variant of setting lead to creating the files 
which can be directly loaded in UM Input and UM Simulation programs. 

 
Notes. 1) Severe solution provides zero eigenvalues for eigenmodes that correspond to free body 

motion. However round-off errors during numerical solution lead to appearing the small non-
zero eigenvalues in the spectrum of a problem. Here the frequency option is used. 
 
2) When coupled mass matrix is used the latter variant is obligatory. 
 
3) If you use a diagonal mass matrix it is recommended to use the variant with turned on 
normalize modes and then use Wizard of flexible subsystems. 

Load a *.rst file, select the suitable options and click Create button. Preparing output data takes some 
time that depend on number of nodes, static modes and eigenmodes. Correspondent message informs you 
about results of calculation. 
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11.5. Wizard of flexible subsystems 

Wizard of flexible subsystems (Fig. 11.5) is implemented as a tool within UM Input program and is 
aimed for flexible subsystems data control and transformation. Wizard is also can be used for excluding 
some shapes from the final solution as well as for orthonormalization of modes and excluding rigid body 
modes. Functions of the wizard are quite similar to the ANSYS_UM program. 

 

Control form 

Animation window 

Status line of the animation window 

Control panel of 
animation window 

Information about object 
selected the mouse 

Name of UM object Image mode Name of UM object 

 
Figure 11.5. Wizard of flexible subsystems 
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11.5.1. Animation window 

An animation window of the wizard of flexible subsystems is aimed for visualization of the FE-
mesh, nodes and elements, as well as animation of flexible modes. Common functions of animation 
window are discussed in the Sect. 3.3.1.2. Here we will discuss additional functions of the animation 
window concerning visualization of the FE-mesh.  

 
·  Mouse cursors: 

  node of the FE-mesh; 

  one-dimensional finite element: beam, link, pipe; 

  finite element of shell or plate type; 

  solid finite element. 

· Status line shows information about current selected node or element. 
· Additional buttons that affect for FE-mesh visualization: 

  full/simplified FE-mesh (features of full/simplified will be discussed later); 

  show/hide nodes; 

  show/hide finite elements. 

Besides standard buttons animation window has additional positioning buttons: 
  zoom in/out; 

, ,   rotating around corresponding axis; 

,   shift left/right, up/down. 
 

Use the context menu to hide/show tool panels, see Fig. 11.6.). 

 
Figure 11.6. 

11.5.2. Control form 

Control form includes four tabs. 
· General tab shows general information about the flexible subsystem. 
· Position tab let the user a possibility to change the flexible body position and orientation. 
· Image  tab  contains  control  elements,  which  are  used  for  definition  of  graphical  representation  of  

the flexible subsystem. 
· Solution tab show information about current solution with the help of two descendant tabs: 
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- Modes tab shows information about calculated static modes and eigenmodes, as well as control 
elements for excluding some modes and their orthonormalization; 

- Rigid body shows inertia parameters of the flexible subsystem as a rigid body. 
 

11.5.2.1. General tab 

             
a)                                                                      b) 

Figure 11.7. General tab 
 

When you just started the Wizard of flexible subsystems it has the only tab “Select data file”, see 
Fig. 11.7a. The Data file box contains the last loaded file, if the Wizard starts at the first time this field is 
empty. Use the  button to start the open dialog, see Fig. 11.8.  
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Figure 11.8.  

 
This dialog has the following features: 

· you can load only *.fum files in this dialog; 
· the right panel shows summary text information about the selected flexible subsystem. 

After loading the *.fum file the General tab looks like it is shown in Fig. 11.7b. 
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11.5.2.2. Solution tab 

Let us consider basic features of the Solution tab, see Fig. 11.9. 

 
Figure 11.9.  

There are two tabs in the bottom part of the Solution tab: Modes and Rigid body. 
 

· The Modes tab includes the following components. 
- Summary text information 
- List of modes. Each list item corresponds to a mode of the flexible subsystem and shows the 

following information: 
- index of the mode in the set of modes; 
- type of mode: static or eigenmode; 
- eigenvalue for the eigenmode. 

Every list item has a check box, which is shown if the mode is included to the transformed set of 
modes. 

 
The list of modes is filled according to the following rules:  

- eigenmodes according their eigenvalues; 
- static modes according to the order of their calculation in the FE program (ANSYS). 

 
The list of modes shows the complete set of calculated eigenmodes and static modes and shows the 

flexible mode in the animation window. Besides that the list of modes gives the user a possibility to create 
new reduced set of modes as a subset of already calculated modes. You should turn on the check boxes 
that correspond to the modes you are intended to add to the new subset of modes. 
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- The Animation of modes group contains the following elements. 
- The Animate button starts animation of modes. 
- Track bars Amplitude and Rate set the scale factor and the frames per second for animation 

correspondently. 

Note. Maximal number of frames per second depends on number of nodes and finite elements of 
the flexible subsystem, computer performances and settings of graphical representation of the 
flexible subsystem in the Image tab. 

· The Rigid body tab (see Fig. 11.10) shows information about position of center of gravity, mass 
and moments of inertia of the flexible subsystem. 

 
Figure 11.10. 

· The Data set radio group defines original or transformed data set as a current one. This group is 
enabled if the transformed data set is not created. 

· Transformations group is aimed for orthonormalization of selected flexible modes.  
- Click Transform to start transformation process. A new set of flexible modes is created, the 

source flexible modes is not changed. In the case of successful transformation the Data set 
radio group becomes enabled. Set Data set to Transformed to control the transformed modes 
visually.  

- The exclude rigid body modes flag mostly should be turned on. Turn off the flag when there is 
no possibility to exclude rigid body modes automatically. In this case you should exclude rigid 
body modes manually. 

- The minimal frequency that corresponds to rigid body modes is set in the Frequency box, see 
Sect. 11.4.  

- The Save as button is aimed for saving the orthonormalized set of modes. Input the full path to 
the subsystem in the save dialog (Fig. 11.11). 

 
Figure 11.11.  
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A new input.fss file will be created in the specified directory. To create another data set you should 
select the Original in the Data set group and then prepare the new data set. 
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11.5.2.3. Image tab 

This tab is intended for describing the graphical image of the FE-mesh of the flexible subsystem in an 
animation window, see Fig. 11.12. 

 
Figure 11.12.  

· You can choose simplified or full options in the Image group.  
 
In the full mode you can see information about each node and element in the status line of the window 

when selecting them with the help of a mouse. 
 
If you select the simplified mode then the flexible subsystem is shown as one graphical element with 

all nodes of the FE-mesh. Information about nodes and elements under the mouse is not available in this 
mode. Nodes are not drawn and flexible subsystem has Polygons color, see Color group. Simplified 
mode is intended for big FE-meshes and helps to significantly increase animation rate. 
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11.5.2.4. Position tab 

With the help of this tab you can change position and orientation of the flexible subsystem relative to 
basic inertial system of coordinates SC0.  All  these  data  influence  on  the  representation  of  a  graphical  
image of flexible subsystem in the animation window. 

The next step of creating the hybrid (rigid + flexible bodies) model is describing the interactions of 
flexible subsystem and other bodies of the model. Use the UM Input program for that. 

 

 
Figure 11.13. 



Universal Mechanism 5.0                                                  Part 11. UM FEM module: flexible bodies 

 

11-20 

11.6. Adding the flexible subsystem into a hybrid model 

11.6.1. Adding the flexible subsystem 

Select the Subsystems item in the list of elements in the left part of the constructor window and add a 

new subsystem by the  button, see Fig. 11.14. Choose the Linear FEM subsystem item from the 
drop-down list and then select the flexible subsystem (input.fss)  in  the  open  dialog.  After  loading  the  
flexible subsystem input a name for the new subsystem. 

 
Figure 11.14.  

 

 
Figure 11.15.  

 
Note. After adding the flexible subsystem a fictitious rigid body and a 6 d.o.f. joint are 

automatically created. The fictitious body has a name of solution, see General tab. The 
fictitious joint is not included into the list of elements. The fictitious rigid body and joint 
are introduced into the model for uniform creating joint and force elements between 
flexible subsystem and the rest part of the mechanical system. 
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11.6.2. Flexible subsystem inspector 

After loading the flexible subsystem its parameters are shown in the inspector window. This window 
is similar to Wizard of flexible subsystems. Let us consider basic distinctions of this window. 

11.6.2.1. General tab 

The General tab contains some additional boxes, Fig. 11.16. 
· Identifier is used during the programming under UM environment. Syntax rules for identifiers are 

given in sect. 3.3.2.3.2. 
· Ancestor shows path to the flexible subsystem source data. 
· Angles of orientation (sequence of angles) determine orientation of the flexible subsystem. 

 

 
Figure 11.16.  

11.6.2.2. Position tab 

This tab let the user a possibility to determine initial position of the flexible subsystem in the basic 
inertial frame of reference according to design of mechanical system. 
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11.6.2.3. Solution tab 

This tab is aimed for informational purposes only. Here you cannot change the set of modes, but you 
can animate all modes in the current solution. 
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11.6.3. Features of adding joints and forces 

After adding the new flexible subsystem it is necessary to describe attached joints and force elements. 
Basics of creating joints and force elements are given in the Sect. 3.4.6. Here we will consider some basic 
distinctions.  

· When you describe a joint or a force element for the flexible subsystem you should select a 
fictitious rigid body that has the solution name as one of the body in the joint/force, see Fig. 11.17. 

· A joint or a force element can be attached in a node of the FE-mesh only. You should keep in 
mind  this  fact  during  creating  FE-mesh  of  the  flexible  body  and  specially  create  nodes  so  as  it  
would be a node for each attached joint or force element. If there is no a node in the point where a 
joint/force should be attached to the flexible body, program will find the nearest node for this 
joint/force.  

· In the present UM version forces should act at the body-fixed points. 
 
Describing interaction between the flexible subsystem and the rest part of the model is the final step 

of creating hybrid models. Then you should generate and compile equations of motion (Sect. 3.6) and can 
start simulation. 

 

The body of 
flexible subsystem 
«Car body» 

 
Figure  11.17.  
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11.7. Analysis of dynamics of flexible subsystem in model 

Practically all tools, which are available in UM for rigid body modeling, support flexible bodies. The 
working procedure with the UM Simulation program is described in Chapter 4. Let us consider 
simulation features relating to the presence of flexible subsystems in a UM model. 

Let us consider the UM Simulation tools for working with flexible subsystems. 

11.7.1. Object simulation inspector 

If a model contains flexible subsystems then the FEM Subsystems tab appears on the Object 
simulation inspector. The tab has the Simulation, Image and Solution tabs, Fig. 11.18. 

If the model contains more than one flexible subsystem then the list with all subsystems appears. The 
user can select a subsystem from the list to set its parameters. 

11.7.1.1. Simulation tab 

The Simulation tab contains the following interface elements: 
· The Gravity flag allows switching on/off gravity. It may be necessary when a subsystem does not 

have large displacement. 
· The Switch off all flexible modes flag allows modeling a flexible subsystem as a rigid body. In 

this case the subsystem has only six joint coordinates as a free body. The flag is enabled if the 
subsystem interacts with the object by means of force elements only. 

 

 
Figure 11.18. Object simulation inspector 
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· The Damping group determines internal dissipation, choosing the mathematical model of 
dissipation and parameters of the model. Let us consider the Type of definition group:  
- Linear model allows setting the dissipation matrix as a sum of mass and stiffness matrices 

multiplied by ratios. User can set the values of ratios at his or her discretion. 

 
Figure 11.19. Damping ratio 

 
- When Damping ratio for each mode is checked the dissipation for every mode as a damping 

ratio, Fig. 11.19. The critical damping ratio equal to 1 and separates non-oscillatory motion 
from oscillatory motion. 

The values of damping ratio for the given range of flexible modes can be assigned with the help of the 
dialog window (Fig. 11.20). Use the popup menu to show this dialog. The frequency interval can be 
set by indices of modes (Fig. 11.20a) or by the value of the frequency (Fig. 11.20b). 

   
a)        b) 

Figure 11.20. Damping ratio 
 
Since the flexible modes of a subsystem are orthonormal, values of damping ratio could be calculated 

based  on  the  linear  damping  model.  For  that  it  is  necessary  to  click  the  Calculate button on the 
Simulation tab (Fig. 11.18). You can firstly set values of coefficients of linear dissipation model a and b 
(Fig. 11.21) and then to click the Calculate button to calculate damping ratios for each mode. Values of 
damping ratios are available to edit. 
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Figure 11.21. Linear model of damping ratio 

 
To accept the calculated values for the subsystem click the Apply button. The Cancel button closes 

the window without changing the model parameters. 

11.7.1.2. The Image tab 

The Image tab is identical to the corresponding tabs of Wizard of flexible subsystems and data 
inspector in UM Input program and is described in details in Sect. 11.5.2.3. 
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11.7.2. Variables 

You should use the Wizard of variables to create new variables to analyze, see Sect. 4.3.2. Here we 
will discuss some features, which are connected with simulation of flexible subsystems. 

11.7.2.1. Coordinates 

In the list of coordinates of the Wizard of variables you  can  see  two  groups  of  elements  that  
correspond to flexible subsystem, Fig. 11.22. The first group includes six d.o.f. of a flexible subsystem as 
a free body (coordinates 2.1-2.6) and the second one includes complete set of generalized coordinates of 
the flexible subsystem (starting with coordinate 2.7).  

 
Figure 11.22. Coordinates of the model 

 
Note. Modal coordinates are dimensionless variables. That is why make sense only comparative 

analysis of modal coordinates between each other. 

11.7.2.2. Linear variables 

Please note that kinematical variables (coordinates, velocities and accelerations) are available for 
nodes of finite-element mesh only. If there is no node in the indicated point then the nearest node will be 
chosen and the user will have the correspondent message, see Fig. 11.23.  

 
 Figure 11.23.  
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